
 What is animation?

 

 

Animation is the illusion of motion that is created by displaying 
a series of images or frames, each one slightly different from 
the last, over a brief period of time.

ImageReady lets you make animations by creating a series of 
frames in your graphic file and then saving those frames either 
as an animated GIF or as a QuickTime movie.

In this section, you will learn some basic animation techniques.

Note: In this section, several animations are used as 
examples; you will have to view the web version to get the full 
effect.

   
Tip: When working with animations, make sure you're 
in Original view (click the Original tab if it is not in 
front). You have limited frame-editing ability when 
viewing an optimized version of a graphic.

 



 How do I
create a frame?

 

Adding frames is the first step in creating an animation. When 
you add a new frame, you can use the layers palette to make 
graphic changes to it. (See the next lesson, Working with 
Layers, to learn more.)

Frames are created in a simple process:

1) Go to the Animation palette. Pull down the Window 
menu and select Show Animation. The Animation palette 
shows you a thumbnail of the first (and initially, only) frame 
for the image:

2) Decide when you want the animation to occur. If you 
want the animation to happen when the web page is first 
loaded, make sure that the Normal state is selected in the 
Rollover palette. If you want the animation to happen only 
when a certain rollover effect occurs, select that rollover state 
in the Rollover palette.

  3) Create a new frame. Click on the New Frame button at 
the bottom of the Animation palette:

A new thumbnail representing the new frame will appear next 
to the first. The new frame will be a duplicate of the one before 
it, until you modify it (see the next lesson for details).



 

 How do I
select a frame?

 To work with a frame, you must first select it. Selected frames 
have a blue background. Once selected, the contents of the 
frame appear in the window and you can edit it. You can also 
select multiple frames if you want to make changes to them all 
at once.

●     To select a frame, click its thumbnail.

●     To select a series of frames that are next to each other 
("contiguous"), click on the first frame's thumbnail, then 
hold down the Shift key and click on the last frame in 
the series. It and all the frames in between will be 
selected.

●     To select frames that aren't next to each other 
("discontiguous"), click on the first frame's thumbnail, 
then hold down the Control key and click one at a time 
on the other frames you wish to select. All of the clicked-
on frames will be selected, while those in between will 
not.

●     To select all the frames at once, choose the Select All 
Frames command from the Animation palette menu:

 

   ●     If multiple frames are selected and you want to de-
select one, hold down the Control key and click on it.



   
Tip: When more than one frame is selected, the contents 
of the current frame will appear in the document window. 
The current frame is the first frame selected, and it has a 
black outline:

 

 How do I
delete a frame?

 To delete a frame, select the frame (or frames) you want to 
delete, then click on the Delete Frame button at the bottom 
of the Animation palette:

To delete the entire animation, choose the Delete Animation 
command from the Animation palette menu:

 

 
 



 How do I use
layers to create
the animation?

 

Working with layers is the key to creating an animation. You 
make changes to a frame by making changes to its layers. 

Using Layer effects, you can create several types of animation 
effects. You can:

●     hide or show a layer
●     change or add layer styles
●     move a layer
●     change a layer's opacity
●     change a layer's blending mode

However, just as with rollovers, you need to be aware that 
changes you make using painting and editing tools, color and 
tone commands, filters, type, and other image-editing 
commands, will have a universal or global effect on the layer, 
rather than applying to just the selected frame. If you wish 
your animation to incorporate some of these global effects, then 
you need to create an animation with multiple layers, and hide 
and show the layers as appropriate.

 

 How do I create
a single-layer 
animation?

 A single-layer animation has only one layer, and uses the 
various layer effects to create the illusion of motion. Even with 
single-layer animation, you can create many kinds of effects, 
like moving an object, fading it in or out, making it flash, or 
moving through a series of layer styles. Here's how:

   1) Show the Animation and Layers palettes. If the palettes 
are not already visible, pull down the Window menu and select 
Show Layers, then Show Animation. You should only have 
one frame in the Animation palette to start, and the layer you 
want to animate should be selected in the Layers palette. 

2) Decide when you want the animation to occur. If you 
want the animation to happen when the web page is first 
loaded, make sure that the Normal state is selected in the 
Rollover palette. If you want the animation to happen only 
when a certain rollover effect occurs, select that rollover state 
in the Rollover palette.

3) Create the initial graphic to be animated. If you haven't 
already, create the initial graphic to be animated, and locate it 
where you want the animation to begin. A thumbnail of this 
graphic should appear in the first and only frame in the 
Animation palette.



4) Make a new frame. Create a new frame and select it (as 
described in the previous lesson). This new frame will be a copy 
of the immediately previous one.

5) Make a slight change to the graphic. For example, if the 
goal is for the graphic to move across the screen, nudge the 
layer in the appropriate direction. If you want the graphic to 
fade out, reduce the layer's opacity a little bit.

6) Duplicate steps 4 and 5 over and over, until your graphic 
is completely moved across the screen, or until it is completely 
faded out, or whatever effect you are trying to achieve is 
completed.

If you want to create an even and smooth transition from 
beginning to end, you can use a technique called "tweening" to 
instantly create all of the intermediary images; you only have 
to create the beginning and end frames. (We will discuss 
"tweening" in the next lesson.) However, if you want to create 
an irregular or irratic animation, you will have to create the 
individual frames by hand.

Note: The animation will be smoother, the more frames 
there are in between the beginning and end. On the other 
hand, the more frames there are, the longer the 
animation will take. You must make a decision about the 
number of frames based upon the desired effect.

7) Select the Normal state. When you're done, click on the 
Normal thumbnail to make sure that you don't inadvertently 
make other changes to your animation.

An example of a simple, single-layer animation would be a 
single layer with a round circle, where the layer is moved from 
frame to frame to simulate a bouncing ball.

 

 How do I create
a multi-layer 
animation?

 There are some animation effects that require the use of more 
than one layer. Image-editing tools (such as painting, editing, 
coloring, changing tone, using filters, and editing type) have a 
global effect, changing the edited layer across all frames. Thus, 
one layer cannot be used to animate such changes. For 
example, you cannot have text grow, or shift through all of the 
colors of the rainbow, without multiple layers.

Here's how to create a multi-layer animation:

1) Show the Animation and Layers palettes. If the palettes 
are not already visible, pull down the Window menu and select 
Show Layers, then Show Animation. You should only have 
one frame in the Animation palette to start.



2) Decide when you want the animation to occur. If you 
want the animation to happen when the web page is first 
loaded, make sure that the Normal state is selected in the 
Rollover palette. If you want the animation to happen only 
when a certain rollover effect occurs, select that rollover state 
in the Rollover palette.

3) Create the first graphic in the series to be animated. If 
you haven't already, create the initial graphic to be animated, 
and locate it where you want the animation to begin.

4) Make a new frame. Create a new frame and select it (as 
described in the previous lesson). This new frame will be a copy 
of the immediately previous one.

5) Duplicate the previous layer. Duplicate the previous layer, 
then hide the previous layer using the Layers palette.

6) Make a slight change to the current layer. For example, 
if the goal is to make some text grow, increase the font size of 
the text just a little bit.

6) Duplicate steps 4, 5 and 6 over and over, until the effect 
you are trying to achieve is complete. Make sure that each 
frame has visible only the layers you want to display for that 
frame.

7) Select the Normal state. When you're done, click on the 
Normal thumbnail to make sure that you don't inadvertently 
make other changes to your animation.

Below is an example of a simple multi-layer animation where 
the text grows and shrinks. Each text size is on a different 
layer, and each frame hides the previous layer and shows the 
next one.



   

Important Tip! When you are working with your 
animation, always be sure you have selected:

●     the right frame in the Animation palette,
●     the right state in the Rollover palette, and
●     the right layer in the Layers palette

If you don't, you will often get surprising and undesired 
results!

   The last example in this lesson is a bit more complicated. This 
animation uses both layer effects and multiple layers to achieve 
its effect:

The color of the text changes, going through all the colors of 
the rainbow, one color blending smoothly into the next. How 
was it done? Six frames were created (one for each of the six 
colors of the rainbow). Six layers were also created, and on 
each layer the word "ImageReady" was a different color. All of 
the layers were left visible in all of the frames. In the Red 
frame, the opacity of the Red layer was set to 100%, and the 
opacity of the other five layers was set to 0%. In the Orange 
frame, the opacity of the Orange layer was set to 100%, and 
the opacity of all of the other layers was set to 0%. (And so 
on.) Three intermediary frames were then created in-between 
each of the original six color frames, and the opacity of the 
layers were slowly shifted from the one color to the next. Here 
are the first five frames of the animation:

 

 

 

  

 



 What else
can the Animation
palette do?

 

Throughout this part of the course, you have been learning how 
to use the Animation palette to create animations. However, 
there are some features of the Animation palette that we have 
not yet touched upon, including:

●     Matching layers across frames
●     Tweening
●     Looping
●     Delay times
●     Viewing animations 

We will cover these topics in this lesson.

 

 Matching Layers  As you know, when you change a layer using layer effects, the 
changes only apply to the current frame of an animation. At 
times, however, you want the change to take effect for the 
entire animation. Rather than having to repeat the change one 
frame at a time, ImageReady lets you make the change once 
and then apply it to all of the frames. Here's how:

1) In the Layers palette, select the layer you want to match 
across all of the frames in the animation.

2) Choose the Match Layer Across Frames command from 
the Palette menu:

 

 



 Tweening

 

 The Tween command will automatically create new frames in-
be"tween" two endpoint frames. ImageReady will make 
incremental changes to the layer attributes (position, opacity, 
and/or effects) of each frame to create an even continuum of 
frames between the start and end points.

Follow the steps below to tween your frames. (We'll use the 
example of a bicycle crossing the screen to show how it's 
done.)

1) Create the starting frame and the ending frame. Set the 
layer attributes of each. (We created two frames. In the first 
frame, the bicycle is at the left of the picture. In the second 
frame, the same bicycle is now at the right of the picture.)

2) If you want to "tween" the layer effects only for a specific 
layer, select it in the Layers palette. (With our bicycle, the 
wheels were on a different layer from the bicycle frame, and so 
we wanted all layers to be tweened. We ignored the Layers 
palette selection.)

3) Select the two contiguous frames between which you want to 
insert intermediary frames:

4) Click the Tween button  at the bottom of the Animation 
palette. 

5) The Tween dialog box appears:

 



   6) If you want layer effects for all layers to change across 
frames, click All Layers; otherwise click Selected Layer. (In 
our example we wanted all layers to be tweened, so we 
selected All Layers.) 

7) Check which paramaters you want to change across frames: 
position, opacity, and/or effects. (In our example, we were only 
concerned with the changing position of the bicycle, so we 
checked Position, and un-checked Opacity and Effects.)

8) Leave Selection in the Tween With pop-up menu. (Since we 
selected the two end frames, the Tween with Selection option 
was automatically chosen.) 

9) Specify how many frames you want to add between the two 
end frames. (In our case, we said five.)

10) Click OK.

In a few moments, ImageReady creates the new frames:

 

 

   We're done! The bicycle now moves across the page from left to 
right.



   
Note: In multi-layer animations, you cannot use 
"tweening" to create in-between layers. Tweening can 
make incremental changes only to layer effects.

 

 Looping  By default, your animation plays continuously. However, you 
may want it to play just once and then stop, or play a specified 
number of times. To change this setting:

1) Pull down the Looping Option pop-up menu in the bottom left-
hand corner of the Animation palette:

2) Make a selection from the menu: Once, Forever, or Other.

3) If you selected Other, a dialog box will appear. Enter the 
number of times you want the animation to repeat, then click 
OK.

 



 Delay Times  You can control how long each frame of your animation displays 
on the screen. The default is 0 seconds, and the animation 
moves rapidly through the frames. However, you can change 
the default so that there is a longer delay before the next frame 
appears:

1) Select the frame or frames for which you want to change to 
delay. (The change applies to all selected frames.)

2) Click on the Delay value below a selected frame to see the 
Delay pop-up menu:

2) Make a selection from the menu, or choose Other.

3) If you selected Other, a dialog box will appear. Enter the 
length of the desired delay, then click OK.

 

Viewing Animations  Once you are done building your animation, you will want to 
see how it looks. To do this, you can go into animation preview 
mode, which will give you a rough idea of what your animation 
looks like. The animation controls are across the bottom of the 
Animation palette:



You can use these controls to view your animation, step 
through it slowly, find a specific frame you want to edit, etc. 
Just click once on the one you want. 

The controls are very similar to a tape player:

If you want to preview the animation in the default browser for 
your computer, click the Preview in Default Browser button 

in the toolbox  . Your browser will launch and you can watch 
the animation.

If animation timing is critical, it's important to view the 
animation in one or more browsers, because ImageReady may 
not display the timing perfectly.

 

 

 



 How do I save
an animation?

 

ImageReady lets you save your animation in two different 
formats: as an animated GIF, or as a QuickTime movie.

To save an animation as an animated GIF:

1) Select GIF from the Optimize palette (only the 
GIF format supports animations).

2) Pull down the File menu and select Save 
Optimized. A dialog box will appear. 

3) Name the file and select a location. If you 
choose Images Only in the Save as Type pop-up 
menu, an animated GIF will be produced. If you 
select HTML and Images, ImageReady will also 
create an HTML document that displays the 
animation.

4) Click Save. 

To save an animation as a QuickTime movie:

1) Pull down the File menu and select Export 
Original. A dialog box will appear.

2) Name the file and select a location.

3) Select QuickTime Movie from the Format pop-
up menu in the dialog box. (QuickTime must be 
installed on your computer for this option to be 
available.)

4) Click Save. A compression dialog box will 
appear.

5) Make any desired adjustments to the 
compression settings, then click OK.
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